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Introduction 

In this training document we will demonstrate how to add Employees, and Service 

Providers. Employees and Service Providers are individuals or organizations who 

may be assigned work orders or request purchase orders.  Certain Employees will 

be performing operations in Express Maintenance (i.e. Opening, Closing, Assigning 

Work Orders, etc.). We will demonstrate how to set up AUTHORIZATIONS or 

permissions to allow the Employee to perform various actions in the various areas 

of Express Maintenance® as well as preventing them from performing other 

actions.   Let’s get started.  

Employees 

Logging In 

Express Maintenance – Logging In 

This is a multi-user client/server application designed to handle an individual user 

to a large number of concurrent users at one time. Passwords and Login are case 

sensitive.  When logging in, if you receive an invalid Login Name or Password error, 

check with your system administration for the correct login name and password. 

When logging in, if you receive a SQL connection error, check with your system 

administrator, or check the expressmaintenance.com website in the Knowledge 

Base for solutions.  

Employees 

Administration Management Menu 

Express Maintenance Screen Menu – Administration Management Menu 

After login the screen with the Main Toolbar appears with icons for access to 

screens and functions in ExpressMaintenance.  To use the toolbar and icons click on 

http://www.expressmaintenance.com


the desired tab of the general sections of File; Administration; Maintenance; 

Purchasing; Utilities; and Help.   

Employees:  

To input or edit employee records click on the Administration tab.  The 

administration section is used to access various System Setup Screens.  Access to 

the Administration section is limited to the applicable authorized users.  Most of the 

initial setup is completed through Administration.    

From here click on the Employees Screen.  Enter each employee who may be 

assigned a work order (maintenance technician), who may create a purchase order 

or may request a maintenance action (Requestor). Almost anyone can be an 

employee, including contractors and other outside personnel who may enter into 

the maintenance synergy. Employees are not to be confused with Users.  Users 

are all individuals who will be operating/using Express Maintenance.   

When Employees is ‘left clicked’, The Employees Screen opens.  



The Employee screen (below) as used in Express Maintenance as a list of Employees 

or Service Providers who perform maintenance, and/or other employees who will 

be issued work orders or enter purchase orders or individuals who will be 

performing operations in Express Maintenance (i.e. Opening, Closing, Assigning 

Work Orders, etc.). 

Adding an Employee 

To create a new employee record, click on the   on the data navigator bar at the 

top of the data screen.  

The data navigator consists of a series of buttons that enable you to scroll forward 

or backward through records one at a time, go to the first record, go to the last 

record, insert a new record, update an existing record, post data changes, cancel 

data changes, delete a record, and search a record.   



The following figure shows the Data Navigator for the Employee screen.   

Depending on the screen and task to be performed some buttons may not appear 

highlighted if its function is not applicable at the time.  Some buttons are not 

applicable for other data screens.  

To enter a new employee, left click ‘Data View’, and then on the   and a new blank 

employee record will appear as below: 



Enter the Last Name and First Name, email information, and check the box 

‘Available’ and save with the   and the Full Name field will be automatically filled, 

and a new ‘Dialog Box’ will appear. 

If you left click on ‘Yes’ a new ‘Dialog Box’ appears. This informs you if any 

authorization records were added. 

Other data fields may be completed based on User preferences, when done save 

with the  . 

Full Name: Express Maintenance will automatically create the value as with the 

Last Name, First Name.  

Skills: List and special skill(s) of the employee.  Separate each skill with a comma.  

Being consistent will allow you to generate reports of employees by skill sets as 

needed.  

Work Group: Select the work group to which the employee is assigned.  Work 

groups can be shift, trade, or variations of these and other designations.  The 

selection list of work groups is defined under Administration >Codes.  



Employee: ‘Actions’, ‘Access Settings’ and ‘Requestor Settings’ User 

Definitions tabs 

At the bottom of the ‘Employee’ screen are four tabs: Actions, Messages, Access 

Settings, Requestor Settings, and User Definitions. 

Actions: 

Clicking on the Actions tab will open the following. To enter a new action, click on 

the  .  

Clicking on the drop-down menu arrow will show three actions that can be selected: 

Date Employed; Date Terminated; General Notes. 

After selecting ACTIONS, clicking on the ‘Action Date’, or ‘Followup Date’ will open 

a calendar where you can pick the date of the action of the desired follow up. 



When you go to ‘Action Notes’, you can enter any information or notations you 

need for the action. Clicking on the  as seen below, will open up a full text editor, 

where you can customize your notes. 

Messages 

Clicking on the Messages tab will open the following screen: 

You can use this screen to see the status of messages sent to employee, when 

received and when sent. There is also a search function available. Click on the 

will open a ‘Search Dialog Box’. 

Type in what you wish to search for, and then ‘Click’ on Find. A search will be 

performed and any messages with the ‘search criteria’ will be listed. 



Access Settings 

Clicking on the Access Settings tab will open the following screen:    

If an employee will be performing operations in Express Maintenance (i.e. Opening, 

Closing, Assigning Work Orders, etc.), enter the following into the areas provided: 

Login Name; Password. This will allow the employee to ‘Log In’ to 

ExpressMaintenance®. Please note the Access Legend box: 

The color codes of the checkmarks indicate the amount or range of access the 

employee has. Most employees should not have Full Access. Full access allows 

them to enter, edit, and delete data. Full access should be strictly limited to System 

Administrators only. Please also note the Full Administrator line and box. If this 

box is checked the employee is considered to be a system administrator and has 

full access to the entire data base. Selecting this field will override any other access 

limits. This field should be blank on most employees. 



On the right-hand side of the screen you will see a list of categories. 

These categories represent various areas in ExpressMaintenance®. Each category 

can be opened up by clicking on the   will expand the category and it will look 

similar to this: 

Here also access can be limited by checking on each line and selecting the proper 

access classification. This should be done for each category and each line in the 

category.  You can set access for an entire category by clicking on Access Options. 

This will open the following screen. 



You can then set access for entire category, or if you have set up Group Member 

Access, you can assign the group access to this employee here. 

In most cases it is recommended to restrict access as much as possible at the start. 

If it is found that the employee needs a higher level of access, it can be granted by 

the system administrator. 

Some of the other information/lists on this screen are: 

• Password Changed: this is the date that the password was last changed. It

will open a calendar and you can choose the date.

• User Group: This is the group that the employee is assigned to. It is a drop

down menu, and the groups can be added/deleted/ in

Administrative>Codes, or by selecting ‘Manage Codes’ in the dropdown

menu (this is the preferred/easier method).



• Limit to Site: the drop down menu will list all of the sites in the data base.

ExpressMaintenance® allows you to setup unlimited Sites and Locations for

which maintenance is managed.  You can limit a user's access to a particular

site.  To do this, after setting up your sites under the Locations section,

select the applicable site for the individual users.

• Parts Limit to Site: Similar to Limit to Site, but for parts.

• Full Administrative: Covered above.

• Maintenance Technician: If this box is checked, employee can be assigned

work orders, (see the training manual on Work Orders). This should be

checked if employee will be working on equipment and assigned work

orders.

• Check for Updates on Login: If internet access is available, will check for

updates to ExpressMaintenance® whenever the employee logs in. Should

normally be left unchecked.

• Services Due Notification: If this box is checked, the services due icon at the

bottom of the Maintenance screen to flash if services are due.

• Request Due Notification: If this box is checked, the request icon at the

bottom of the Maintenance screen to flash if requests are due.

http://www.expresstechnology.com/WebHelp/locations.html


Requestor Settings 

ExpressRequest® is a separate program for non-maintenance users to submit 

maintenance requests to the maintenance department.  If you purchase 

ExpressRequest®, you must use this screen to setup/manage requesters in 

ExpressRequest®.  

When you click on Requestor Settings, the following screen will open. 

Requester Name - Will automatically be filled in with the name of the employee.  

Allowed Requester - Click the check box to quickly enable or disable your 

requester's. If the box is checked, the requester is enabled. 

Default Computer - The name of the computer on which the requester will make 

requests.  Each requester can be set to a specific computer or all computers. 

Default List Status - Set which list ExpressRequest® will default to when each user 

logs in.  Some other options include Draft, Submitted, and Reviewed.  To view the 

complete list, click the drop down arrow.  



Default Site - Quickly select a site & location for each requester.  Simply click  to 

view all Site/Location options. Or once again you can select all to give the 

requester access to all sites & locations 

Default Location - Pick requester’s location from the available list depending on 

the chosen site (see Default Site). To view any available location, click 

administration>locations. 

Employee Request Summary – Lists all requests from requestor and their current 

status. 

Adding a Service Provider 

To add a Service Provider or Outside Contractor, click on the   in the Employee 

Screen and the screen opens ready to add a new employee. Follow the same steps 

outlined above but instead of entering an Employee, enter the Service Provider Last 

and First Name, email and check box ‘Available’. For Work Group and Position, 

the title ‘Contractor’ or ‘Service Provider’ can be added to the codes list. Save the file 

by clicking on the    . The contractor will now be available to be assigned work 

orders. 

Note: For each Service Provider added to the Employee table, there should be a 

specific contact for the Company in the Company table for all Customers, Vendors, 

Manufacturers and Carriers. 

http://www.expresstechnology.com/WebHelp/locations.html
http://www.expresstechnology.com/WebHelp/locations.html
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Introduction 
In this training document we will demonstrate how to set up Locations and Sites in Express 

Maintenance®. Express Maintenance® offers the ability to separate equipment and parts 

based on sites and / or locations you define.  It is extremely important that these tables be 

thought out prior to entering any other information. It is suggested that you use a map or 

aerial photo of your site and / or floor plans to aid in setting up the various locations and 

sites. Let’s get started.  

Locations/Sites 

Locations 

Locations  -- Express Maintenance Screen Menu  

The Administration section is used to access various System Setup Screens.  Most of 

the initial setup is done through Adminstration.  The following reflects the Location 

options available under the Admnistration module. [1] 

Administration Management Menu 

Administration Menu 

The Administration Menu is where you enter the setup data needed for Express 

Maintenance.  In this case we will focus on Locations.  Keep in mind you can return 

to any of the nine options to enter additional data at any time.  

Click on Locations and the Locations Screen opens.  



The Overview Screen shows all of the Sites that have been entered.  

. 

To add a new Site, click on the ‘+’ data navigator and the screen opens ready to add 

a Site. 

Insert a brief descriptive name for the Site, a Company for the specific site as this 

will be useful in designing reports that join with the site or location. Insert the 

Address, City, State, and Zip code. Once all the descriptive information is added, 

save it by clicking on the ‘√’.  

Sites & Locations offers the ability to separate equipment and parts based on the 

sites and / or locations as you define.  Express Maintenance allows you to define 

unlimited Sites and Locations.  In general, sites can be different buildings, cities, 

docks, hangars, terminals, or warehouses,  



By ‘double clicking’ on a specific Site, or selecting ‘Data View’, the Locations view is 

brought up. Locations are specific buildings, departments, divisions, zones or even 

specific parts storage locations (i.e. Racks, etc.).  A field is available in the Parts 

{Maintenance>Parts inventory>Data View} screen for the actual shelf / bin where 

the part may be found.  

You can limit Users of Express Maintenance to only have access to specific site(s). 

This will limit the user to only see Units (equipment), Parts, Work Orders and 

employees associated with their designated Site.  All Locations within the Site will 

be available to the User.  You cannot limit locations within a site.  



To add a location, select a specific site and right click your mouse, a drop-down 

menu will open Select ‘+’ and to add the new Location and Description.  In this case, 

Purchasing  was added to the Locations table for  Coumbia Helicopters.  

Insert a brief descriptive location name and description for the location name. Once 

all the descriptive information is added, save it by clicking on the ‘√’.  

To add additional locations, repeat the process. In the example above, you find 

Locations for Administration, Airframe Repair and Avionics as well as others.    

Summary: 

Express Maintenance enables you to define Sites and Locations for each Site.  In 

general, a Site can be different facilities, buildings, cities, fixed base of operations, 

mines, ports, repair stations, terminals, or warehouses, etc.  Locations are generally 

specific buildings, departments, divisions, floors, or levels. An additional field is 

available in the Parts screen for the actual shelf / bin where the part can be found. 

You can limit users to only access a specific site when they use Express 

Maintenance.   
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Introduction 

In this training document we will demonstrate how to set up Companies in Express 

Maintenance®. What should be entered in these tables are not only information on 

your company, but all vendors, contractors, suppliers, and manufacturers, as well 

as customers if you bill for services. Let’s get started.  

Companies 
Companies -- Express Maintenance Screen Menu  

The Administration section is used to access various System Setup Screens.  Most of 

the initial setup is done through the Adminstration tab.  The following reflects the 

Companies options available under the Admnistration module. Companies is the 

table for all Customers, Vendors, Manufacturers and Carriers.   

Adding Companies 

Click on Companies button. The Companies screen opens as shown below.  



The screen is designed on Primary/Detail relationship. For each Company entered 

(Primary Record), Addresses, Contacts, etc.. (Detail Records) can be entered.   

These are used to keep contractors, vendors and suppliers records as well as 

customer records if you bill for services.  The Companies table is for all Customers, 

Vendors, Manufacturers and Carriers.  Before you can enter certain data (vendors, 

contractors, etc.) in some other tables, you must enter certain data in the 

Companies table.  

To look at the information (data) on a particular company, select the company by 

clicking on it in the Overview screen, an then ‘clicking’ on Data View, or just ‘double 

click’ it, and the Data View screen appears as below with the Companies 

Information that has been entered. 



You can look at the information entered, including address, contacts and any other 

information entered. You can also modify the information by just clicking on the 

field and entering the new information and clicking the ‘√’ before leaving the screen 

to save it. If you forget to save, the information will revert to what was last saved. 



To add a new Company, click on the ‘+’ data navigator at the top of the screen. 

And the table will automatically shift to the Data View tab with a blank record ready 

for information to be entered.  



Enter the company information on the top portion of the screen followed by 

detailed information including addresses, contacts, phone numbers with 

extensions, e-mails, etc. 

Company Name: Insert a Company Name.   

Account #: If you are not already using a Purchase Order system as a part of your 

company accounting software you may choose to create an Account # for the 

company.  This design is to allow users to use the PO system without having to be 

highly knowledgeable of the company accounting system.  Examples of this include 

the fact that the screen does not require a valid account of each line item.  

TaxID: The federal tax Id for the company usually used with vendors. 

Terms: Select the terms for this vendor or customer.  

Credit Limit: The credit limit the vendor or manufacturer has approved for your 

company. 



Labor Markup %: Indicates a percent to markup labor on work orders when 

performing work for the company. 

Parts Markup %: Indicates a percent to markup parts on work orders when 

performing work for the company. 

Email: The primary email address for sending copies of documents, reports, work 

orders, request for quotes, etc. 

Website: Optional to the company website.  

Address, City, State, Zip: The address for the company.  

Country: The country of the companies address. 

Attention: The primary contact person. 

License: Any applicable licensing information you may want to maintain. 

Type: The user defined type of company.  

Check Boxes: Select the applicable check boxes for each customer/address.  We 

have found checking the Customer box, Vendor box, and Manufacturer box is 

the most effective set-up for the Company Table.  

Once all the descriptive information is added, save it by clicking on the ‘√’.  



Adding Contacts 

To add contacts, click on the Contact tab and as needed.  This tab allows you to 

enter unlimited contacts for each company.  Data fields include Name, Department, 

Phone, Extension, Cell Phone, and Email Address.   

The Notes tab allows you to enter details specific to the company for future 

reference. in addition to selecting a Follow-up Date from the pull-down calendar.   



Other Features 

Also in the Data View tab, you can select a reminder for a Follow-up Date from the 

pull-down calendar.

There are also an additional four user defined fields for each company. These could 

be used for criticality, quality, certification, or calibration purposes. 

Buttons 

Envelopes allows you to print envelopes of one or more companies.  Labels allows 

you to print mailing labels for one or more companies.  

To Print a list of your customers / vendors you can use the printer button on the 

tool bar of the company’s screen.  This will give you a complete list of all the 

companies in the table.  



Print List   Print Envelope    Print Labels    Print Profile 

Searching for a company is done by using the Search button in the companies 

screen.  You can look up a company by several different field values such as name, 

city, state, zip code, etc.  Select how you want to search for a company, enter the 

corresponding information in the Value field and click the Search button. 

Companies is used to enter ID, Terms, and Label Information.  Before you can enter 

Purchase Orders, you must enter certain data about vendors.
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Introduction 

In this training document we will demonstrate how to set up PM’s and Repair and/or 

Breakdown Services to be performed on the equipment/units. It will also demonstrate how 

to schedule the services and to add service notes or instructions for the service that will be 

printed on the Work Order (WO). Let’s get started.  

Services can be associated with the units (equipment) and setup as PMs in the 

Maintenance / Units screen under the Services tab.  Once the service is associated with a 

Unit, you can create notes that relate to that unit and that specific service.  We will cover 

this more later. 

Services 

Administration Management Menu 

Services -- Express Maintenance Screen Menu  

The Administration section is used to access various System Setup Screens.  Most of 

the initial setup is done through the Administration section.  The following reflects 

the Services options available under the Administration module.  

Administration Menu 

The Administration Menu is where you enter the setup data needed for Express 

Maintenance.  In this case we will focus on Services.  Keep in mind you can return to 

any of the nine options to enter additional data at any time. 



Click on Services button.  The Overview tab will show all the current services.   

Clicking on the Data View tab you’ll find details defining the specific service (PM) of 

interest.  While there are services already entered, they are primarily for example 

only.  You will want to enter the services that meet your requirements and use the 

terminology common to your industry and equipment. We suggested you enter the 

service in this format: <Noun> - <Verb> - <Interval/Period> - <Online/Offline> (If 

needed) 



Entering a Planned/PM Service 

To add a Planned /PM Service click on the ‘+’ at the top of the screen in the data 

navigator area. 

The Data View screen will appear with a blank template ready for your service to be 

entered.  

At this juncture begin by filling out the following:  

Service: 

The Service Description (name) may be up to 35 characters long.  Note the naming suggestion is a 

noun, follow by a verb, followed by an alpha numeric.  

Category:  

The service category to which the service applies, i.e. PM; PdM; Repair, etc. [2] 



Work Group:    

Indicates the default work group for handling this service.  This is useful for searching, sorting 

services and work orders.  

Cost Center:   

You can define Cost Centers with Express Maintenance.  All services can be applied to any given cost 

center.  This is a recommended budget category or expense code for the unit (equipment).   

Service Reference:   

Original Equipment Manufacturers Manual; Ranking Index for Maintenance Expenditures; Charts; 

Graphs; Drawings; Flowcharts; Critical Spares List; Standard Practice Sheets; Job Instruction Sheets; 

etc. 

Labor Estimate:  

The estimated labor time (hours rounded off to 0.25 hours). 

Cost Estimate:  

The estimated cost of the service if done by an outside contractor.  

Scheduling Services 

To schedule the services, start with renewal period and interval for the service.  

Period {Renewal Period}:  

The default period for which the service should be performed and re-scheduled.  Options include 

Days, Hours, Miles, Weeks and Years. This is only the default and the actual service period can be 

changed at the Unit (Equipment) level.  This field corresponds with the Interval field.  

Interval {Renewal Interval}:  

The interval in which the service should be performed and re-scheduled.  This field corresponds with 

the Period field.  For example, if “Months” is selected in the Period field and “3” is entered in the 

interval field, then the Service is to be performed every 3 months (quarterly).    



Basis: Each time a service is completed on a unit or group of units you will need to define when the 

next time the service needs to be performed.  It can be triggered by three different events: 

Work Order Completion (WOC):   

A work order is a document that instructs the maintenance person in what is to be done.  Once the 

Work Order is completed and properly closed out in the database, the date completed triggers the 

next scheduled service based on WOC date. It is recommended to use WOC’s for services of less 

than every 6 months.  

Service Original Scheduled (SVS):  

Reschedule based on the date of the original scheduled date rather than the completion date.  It is 

recommended to use SVS for services needed equal to or greater than every 6 months.    

Work Order / Manual (WOM):  

Reschedule based on manually selecting the next desirable date for the service.   

Logic:  

Select the Renewal Logic for setting the exact date for the re-scheduled service.  Your options are:  

Calculated Date (CD): Re-schedules based on the date calculated from the Renewal Period, 

Renewal Interval, and Renew Base On.  

Calculated Weekdays Only (CW): Typically, Monday through Friday, however you may have 

24/7/365 schedules that redefine a weekday unique to your industry or operation (i.e. 

nuclear power plants, mining operations, airports, maritime applications, etc.)   

Specific Date in Month (SDm): Re-schedules based on the calculated date and then it is 

adjusted to the specific date of the month.   
Fixed Day of Week (FDn): Re-schedules based on the calculated date and then is adjusted 

to the specific day of the week within the month.    

In Requests:  

Select this option if you want the service to appear in the lists of services in Express Request. 

Separate WO: Separate Work Order option, when checked, indicates this service should always be 

put on a work order by itself  rather than with other services that may be scheduled for the same 

time period.   

Affects Calibration: Select this option to designate that the service may affect calibration. 



When you’ve completed selecting your options and filling out the fields in this top 

section, click on the green ‘√’ to post your changes.    

Adding Instructions or Notes to a Service 

To add Text for a specific Service right click in the Text box under General Notes or 

Safety Notes, 

The selection tool opens a circular compass of eight options, select the Editor  

A text editor screen will open. From this Editor screen text can be added or cut and 

pasted from another document similar to Microsoft Word. 



Enter the desired text for the maintenance service, or use cut and paste from 

another document (i.e. Maintenance manuals) and close the screen to save or use 

File>Exit and the text will be saved in the text box. This text is what will print on the 

WO when this Scheduled Service is converted to a WO. 

Adding a Repair or Breakdown Service 

To add a Repair or Breakdown Service click on the ‘+’ and the screen opens ready to add 

a new service. Follow the same steps outlined above but instead of entering a PM Service 

Name, enter the Repair required in Service, Category, Work Group, and Cost Center 

Boxes and save with the ‘√’. Leave the PM Schedule selections blank. 



When entering Service Names, it is better to put the noun first and the verb 

second. This helps when sorting the Service History to look for recurring events, 

(Example: Bearing - Repair instead of Repair - Bearing). 

Customizing Views (Arranging Columns) 

The easiest way to arrange grid columns is to left click on the column heading and 

drag the column to the desired position.  However, you can also click on the Grid 

Properties button in the upper left corner of the Grid.   

A grid properties window (see below) will open. 



The Grid Properties window allows you to define which columns will be displayed, 

the order, and column titles.  You have the options to select Service; Category; 

Work Group; Cost Center; Period; Interval; Basis; Logic; In Requests; Separate 

WO; Affects Calibration; Reference; Labor Estimate; Cost Estimate; and/or 

Record Number available for use as needed.  We recommend selecting only those 

that you find useful.   

Finding Services 

Because Express Maintenance includes a Report Builder that allows you to extract 

and report on data in user definable formats and sorts, special attention is 

suggested in naming service descriptions.  There are several methods of finding the 

service you are looking for.  

If you ‘click’ on the Search Data icon , the following search menu opens: 

Enter in the text you are searching for and Express Maintenance will list only those 

Services with the search text in their name. 

If you ‘click’ on the Filter Data icon , the following search menu opens: 

You can enter search criteria in as many of the columns as you want and Express 

Maintenance will provide a list of those Services that have have all of the search 

items.
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Introduction 

In this training document you will learn how to add cost centers to EM. The purpose of cost 

centers varies and is dependent on how you run your accounting as a company. In most 

cases your EM Cost Centers will be a duplication and expansion of your current accounting 

codes for maintenance.  

Cost Centers 
Adding Cost Centers  

Express Maintenance Screen Menu – Cost Centers  

It is often desirable to associate services and parts usage with a cost center or 

budget item.  Express Maintenance® has the ability to completely setup cost 

centers as used by your organization.  Once cost centers are setup, they are 

available in a picklist where services or parts are entered in a Work Order.  The Cost 

Centers screen is used to list Cost Centers for use in collecting Costs on Work 

Orders.  As data is accumulated, it can be compared and tracked in relation to 

budget considerations.  You can also export work order expenses along with cost 

centers for the purpose of importing data into other applications.  

Cost Centers : To access the Screen Menu  options, click on the Administration 

tab and select “Cost Centers” 

The following is a sample screen shot: 



To add a Cost Center, click on the ‘+’ on the data navigator and a data entry line 

appears and is ready for the Code, Description, and Budget to be entered  

You will be taken to the data view to enter the following fields. 

Cost Center {Code}: The alpha / numeric cost center code as used by your 

organization.   

Description: The description or name of the cost center. 

Budget: The annual budget amount for the cost center. 

Link Field: Available field to link the cost center with other applications such as  

accounting.  

Enter the desired information and save with the ‘√’  

and the Cost Code screen will fill and it looks like this: 

Repeat as needed to add more Cost Centers.
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Introduction 

In this training document we will demonstrate how to set up and use the parts Data Base in 

Express Maintenance®. The parts section of Express Maintenance® is used to maintain 

data about Parts Usage, Parts inventory, Parts Receiving and Parts Reports.   

Parts 

Accessing Parts Data Base (DB) 

Parts -- Express Maintenance Screen Menu  

To access the Screen Menu options, click on the Maintenance tab. [2] To access it, 

click on Parts Inventory. 

Express Maintenance Screen Menu – Parts  

The Parts Menu of Express Maintenance is used to maintain data about Parts 

Usage, Parts inventory, Parts Receiving and Parts Reports.  Parts inventory is 

affected by three activities in Express Maintenance:  

1. Increasing Parts Inventory – Receiving Parts

2. Decreasing Parts Inventory – Completed Work Orders

3. Increasing and Decreasing Parts Inventory – Parts Transfers



The Parts screen of Express Maintenance consists of two tabbed panels.  The 

tabbed names are Overview and Data View This allows users to manage 

everything related to Parts from a single screen.  The Parts screen is first displayed 

as shown below.   

Adding New Parts 

The editing or inserting of a part record is done by clicking the Data View tab at the 

top of the screen. The screen will open: To add a new Part, click on the ‘+’ (Insert 

Record) button on the data navigator at the top of the screen: 

and the screen opens ready to add a new Part. 



Data Fields for Parts are:  

Description: The name / description of the part starting with a noun, followed by 

adjectives, then alpha / numerical attributes.   

Part Number: Optional part number.  You can have Express Maintenance assign parts 

numbers automatically  (recommended unless you already have an internal parts 

numbering system) and optionally include a prefix.  Or you can enter them manually 

Type: Type is a sub-set of a category (see next item).  For example, bolt, nut or rivets are 

types of fasteners.  

Category: Define the category of the part, this is normally a general attribute.  For 

example: Fastener.  

Criticality: Define if the part is Critical, Noncritical, Non-production, Production, or Safety. 

Primary Vendor: Select the primary vendor who supplies the part.  

Vendor Part Number: Enter the primary vendor’s part number.  

Manufacturer: Enter the manufacturer of the part.  

Manufacturer Part Number:  Enter the manufacture’s part number.  

Site: Site specific to where the part is located.   

Location: Location specific to the site where the part is located. 

Replacement: Optional replacement part selected from existing parts (parts already in 

Express Maintenance). 

Shelf and Bin: The actual shelf and bin where the part is located.  (example: S1 B2)  

Units: Define if the part is sold as a Box, Case, or Each depending on how it is ordered.  

Startup Quantity:  The initial quantity found when starting with Express Maintenance.  

Quantity on Hand: The current quantity on hand of the part.   



Minimum on Hand: Determine the minimum quantity needed to have on hand.  You can 

have Express Maintenance warn you when the quantity on hand falls below a desired 

minimum by setting this feature in defaults.  

Maximum on Hand: Determine the Maximum quantity needed to have on hand. 

Current Cost:  The current cost of the part. 

Billing Price: The price that should be charged for the part when used.  

Image / Picture: An image or picture of the part, we recommend if you want digital images 

of the parts to store the images in a file or folder on the server and add the hyperlink in the 

attachments.   

Record Number: Shows the Record number of the Part. This Auto Populates when record 

is saved for the first time. 

Enter the Description, Part Number, and enter data in any other Parts fields and 

save with the ‘√’. 

The Parts screen has eight tabs along the bottom for User Defined Fields, 

Attachments, Notes, Sources, Units (Equipment part is used on), Analysis, 

Receiving History, and Usage History. Use these Tabs as need to capture any 

additional Parts data or information. 

The Receiving History will display the results of receiving records and the Usage 

History will display the results of using Parts on Work Orders.  

Notes: You can add any notes on the part you want or need.  You can double click 

in the notes field to open a larger window for inserting/editing notes.  



Duplicating Parts 

Once a part is in Express Maintenance, you can duplicate, or add a similar part by 

using the Duplicate button. First, make sure you have the part you want to 

duplicate by double ‘clicking’ on it in the Overview section. The Parts ‘Data View’ 

screen will open. Then ‘click’ the ‘Duplicate Unit’ button.      

You will be prompted for information you wish to duplicate and the number of 

times to duplicate the unit, and the following screen opens: 



To use the tool review the check boxes, enter the number of duplicates and click , 

the Confirmation Screen appears: click ‘Yes’. 

Should this Warning message come up just click ‘Yes’. 

And the following Screen opens, verifying that the Part(s) were duplicated.  



There is no notation that identifies this as a duplicate Part, however if you go to the 

‘Overview’ it can be seen that the Part is now listed twice and can be modified to 

represent the Part desired from the duplication.  

Parts Inventory Settings 

Parts are affected by the Default settings found under Administration (settings 

made under Configuration are system wide). Click on the Configuration button 

and you will see screen is divided into several sections.   



Selecting the Parts Inventory should display the following:  

Parts Inventory options and their impact will be discussed during “Entry of 

preferences for Parts data”, and how to select options to include how pick lists can 

be sorted and searched.  

Parts - Overview  

The Parts Overview screen enables you to lookup Parts from a single screen.  The 

Overview screen is displayed below. This screen does not allow for editing of data.  

However, it does provide an effective way of locating parts. 



The Parts Overview displays a Part or list of Parts based on defaults or search 

criteria. You can double click on a specific part in the Overview screen and the 

program will switch to the Data View Screen for editing of the selected Part.  

Search by clicking the magnifying glass button in the overview. Enter the ‘search 

criteria’ in the highlighted box and click ‘Find’. This searches in all parts fields for any 

criteria that is entered into the search box. 

Show/Hide/Move Columns 

You can Show/Hide/Move Columns for any grid in the system. The easiest way to 

arrange columns is to left click on the column heading and drag the column to the 

desired position.   

However, you can also click on the Show/Hide/Move Columns button in the upper 

left corner of the Grid. The Show/Hide/Move Columns window allows you to define 

which columns will be displayed and the order displayed.  



Show/Hide/Move Columns is used to modify the fields being displayed. You can 

arrange columns, turn column display on / off.  

A very useful application of using the grid properties is in searching the parts inventory for 

critical parts and or critical spares.  This is accomplished by placing a check in the Criticality 

option in the Parts grid.  The following screen shows the results, in this case with Critical 

parts at the top of the list.  



Context Menu 

On the Data Navigator you will find a Context Menu that appears for the Screen 

being viewed.   

Hovering over each icon will display its capability, put the cursor on the icon and 

hover and the button description will appear.  

Define Parts Screen Layout 

To Edit the Parts Screen Layout/ Parts User Defined Fields.  

In the Administration Tab, Click Configuration then the Parts Inventory. Click the 

Define Parts Screen Layout >> Button.  



Parts Layout Template 

From the Parts Layout Template you can customize the User Defined Field. To 

change the User Field Labels use the field label button, this tool also changes the 

Tab names and starting Tab for Parts.  These will be discussed later in training.   

Later Training will cover features such as the importance of matching Part Category 

to Unit Category. 

Parts Inventory / Parts Re-Ordering 

The Parts Re-Ordering screen is an effective utility for quickly reviewing parts 

inventory.  It reflects the items that are due to be ordered and enables you to print 

reports or generate purchase orders.  You can access Re-Ordering from 

Maintenance tab and click Inventory Analysis.   



This action opens the Inventory Analysis screen shown below for reviewing 

inventory activity and balances. 

Select the Re-Ordering tab will bring you to the following screen. You can print the 

report or generate purchase orders from this Parts Inventory Analysis / Re-Ordering 

Screen. Simply select the site and click search to instantly view all parts that have 

fallen to or below minimum quantity on hand.  

For Parts with a Quantity on Hand entry and a Min/Max the reorder quantity will be 

calculated and displayed when ‘Search’ is clicked. Other field parameters (Site, Part 

Type, and Part Category) can be set prior to this search.  These will be discussed 

later in training.  



Creating Purchase Orders (PO’s) 

To create PO’s or Purchase Requisitions click the Create Purchase Order button 

button after you have performed a search for parts.  This following screen opens. 

The drop down menu allows you to create a Purchase Order for a single selected 

part, or a Purchase order for all parts returned in the search for this particular 

vendor. 

Selecting either one, will open the Purchase Order screen below. The Purchase 

Order screen is flexible and user friendly in allowing data input.  The data fields and 

other details will be discussed in Purchase Order screen training.

 



Parts Inventory Analysis 

The Parts Inventory can be searched by inserting the desired dates, and/or Part 

Type, and or Part Category, and/or Site Name and click the ‘Search’ button.  

Express Maintenance® will list all parts along with the Beginning inventory, 

Receipts, Used and Ending inventory as applicable for the entered date range. The 

’Update Quantity On Hand’ button is available in this screen. Its use will be 

discussed in later in training. 
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Introduction 
In this training document we will demonstrate how to enter Equipment (Units) into 

Express Maintenance® Data Base.  We will also be covering how to customize the 

various views and tables to suit your needs and preferences. Also, part of this 

document is assigning and scheduling Preventative Maintenance (Scheduled) 

Services to Equipment and assigning parts to those services and equipment. Let’s 

get started.  

Equipment 
Equipment (Units) Screen Menu 

Equipment - Express Maintenance Screen Menu 

The Maintenance Menu is where you will perform most of your daily processing 

and reporting of work.  This is where you or your Maintenance staff will maintain 

Unit (Equipment) data, Unit Services, open and close Work Orders, and generate 

reports on key performance indicators. In this training session we will be working 

primarily with the Equipment (Units Section).  

To access the screen menu click on the Maintenance tab.  

Now select the Equipment button and click on it opening the Equipment screen. 

ExpressMaintenance® uses the term “Equipment” to refer to any item for which 

maintenance related data is used or saved.  Initially, capital equipment that is 

critical to production is first entered to populate the equipment table.  Other, less 

critical, categories of units can be added later, these can include antennas, 

buildings, hoists, HVAC equipment, motors, vehicles, etc., as needed to meet the 

scope and scale of your needs.  



Equipment  

The Equipment screen of ExpressMaintenance® is used to work with all data 

related to Equipment and other Unit items. Clicking on the ‘Data View’ tab open an 

individual Unit (Equipment) screen below. The screen contains the primary Unit 

information in the upper half.  Secondary data is found under the thirteen tabs 

located in the lower half of the screen.   The Units screen opens to show the 

following:  

To add new Equipment, click on the ‘+’ on the data navigator.  



The screen opens ready to add a new Equipment record: 

Enter the Name, Type, Category, Make, Model, Serial #, Unit Number, Site/

Location, and other fields of information if available and save with the ‘√’.   

More detailed data is found in the middle of the screen where you will find a row of 

tabs including User Defined, Lease & Warranty, Device, Attachments, Vehicle, 

Notes, Safety Notes, Sources, Service (PMs), Service History, Downtime, Parts, 

Work Orders, Counts, all are available for data entry or for use as data is displayed 

in them. When done always save with the ‘√’.   



In this case we use the Attachments Tab to enable Maintenance technicians to use 

the latest applicable data by having the original equipment manufacturers owner 

manual, parts list, and troubleshooting documents to ensure all maintenance is 

performed to standards specified in approved instructions. All attachments must 

be saved in a folder that is accessible to ExpressMaintenance® and its users. 

To ‘open’ an attachment, ‘double click’ on it and it will open in another window. 

To add new Equipment using the Duplicate button,  click the ‘Duplicate’ 

button and the following screen opens: In this case, let’s say you needed to increase 

10X to meet customer demand from your production, then select 10 for the 

Number of Times to Duplicate as shown in the following figure. 



To use the tool, review the check boxes, enter the number of duplicates and click 

‘PROCEED’, the Confirm appears, click ‘Yes’. 

When the Duplication is successful this screen comes up: 

And the Equipment record will be duplicated and displayed on the screen with a 

dash and a number after it.  



The new Equipment record is ready to be modified to fit the new Units data 

information to represent the Equipment desired from the duplication.  

Current Count and Count Date 

Current Count is used if your Unit (equipment) requires maintenance on a count 

basis such Hours of Operation, Cycles, Miles, or any other form of measurement 

that is not time based.  

Count Date is the date for which the current value applies.   

Counts are entered in the Equipment screen along with the date the count was 

taken, the ‘Count Date’.   

After entering Count and Count Date the screen looks like this: 

Services (PMs) can be scheduled based on a count field such as hours of operation, 

miles or cycles. The Count field in the unit’s screen is used to track preventative 

maintenance frequencies in these situations.   



However, unlike dates, ExpressMaintenance® has no direct way of knowing the last 

count for a particular unit.  The solution for this is to periodically update the 

Current Count filed in the Units (Equipment) screen.   



Update Unit Counts  

Updating of counts can be done with one of four methods. 

Method 1 is to update the Current Count field in the Units screen one record at a 

time.   

Method 2 – use the Update Counts screen and enter the current count for each 

Unit in grid format. This is the most commonly used method of updating 

counts.  To navigate to the Update Counts screen, use the main screen menu 

Maintenance.  Click on the Update Counts button. 

The following Update Counts screen appears: 



Click ‘Search’ and all Equipment with Counts will display in the list and be ready to 

be updated.  All Units with something greater than 0 are listed in the grid and can 

be quickly updated to their latest count.  Be sure to include the Count Date and 

click the ‘Update Services & History’ button to save all new counts and dates 

entered 

Method 3 can be used to Update Counts screen and import current counts from 

another database or file (access, excel, etc.), that is based on an ODBC (Open 

Database Connectivity) Data source. This method is not completely covered in this 

training document as it requires advanced IT skills for importing the information.    

Option 3 is helpful in situations where your equipment is linked to some type of 

automated systems and the current count is readily available in digital format.  The 

user is assumed to have some knowledge of ODBC database setup in Windows to 

utilize this feature.  You must have a table or spreadsheet which contains at least 

the following three fields: 

1. Name – the name of the unit being updated.

2. Count – the current count of the unit.

3. Date – the date that corresponds with the count being imported.

You will be prompted for a user login name, password, and QDBC DSN.  Once the 

OBDC DSN is entered and connected, you should select a table from which the 

import will come.  Next, click Ok and the data will be imported into the Update 

Counts screen.  Be sure to click the ‘Update Services & History’ Button to save all 

new counts imported.   

If you have a specific application need, such as conveyor systems; robotic assembly 

applications or complex manufacturing and assembly applications contact 

Maintenance Asset Solutions (MAS) to accelerate development using ODBC Data 

source implementation.  



Method 4 - In the Work Order screen counts can be updated. Below are the data 

fields used (circled).  

Equipment downtime can be recorded for downtime or portions of total downtime 

for reporting purposes.  When the Completed date is entered and saved the Counts 

fields will be updated for the Equipment the WO is open against.  

Equipment (Units) Defaults 

Equipment records are affected by the Configuration settings found under 

Administration: 



Opening Equipment (Units) displays the following:  

Defaults and their impact will be discussed later during training. Topics to be 

included are Define Screen Layout & Fields; Query All Units on Open; Auto Number 

Units; Unit Number Prefix; Next Unit Number; Default Units Search Field; and User 

Defined Tab Name as needed.  

Overview of Units - Show/Hide/Move Columns 

You can set grid properties for any grid in the system.  To access the grid properties, 

click on the Show/Hide/Move Columns button in the upper left corner of any grid.   



Show/Hide/Move Columns button opens the following screen:  

Show/Hide/Move Columns is used to modify the fields being displayed. You can 

arrange columns, turn column display on / off.  

Data Navigator 

The Data Navigator provides users control for navigating through and manipulating 

records in a table.  Data records may be displayed in a grid or a single record 

format.  The data navigator consists of a series of buttons that enable you to scroll 

forward or backward through the records one at a time, go to the first record, go to 

the last record, insert a new record, update an existing record, post data changes, 

cancel data changes, delete a record, filter data, and search a record. 

The following figure shows the Data Navigator for the Equipment screen.  

Depending on the module and task to be performed some options may not appear 

or be highlighted if its function is not applicable at the time.  Some buttons below 

are not applicable for other data screens.  



Locating a Unit 

To locate a Unit, from the Maintenance tab, click the Equipment Icon, followed by 

the Overview tab.  

Searches for units, equipment, can be performed by the name or any other field.  

As units are entered into EM, they can be assigned a unit number (either 

automatically or manually) in the equipment list and ideally labeled on the unit with 

a defined site and location.  

When searching for a unit by name for example, select the Name column. If the 

search box is not displayed, ‘click’ on the Search Icon  and type in the search 

box the Equipment name. This searches in all Name fields for anything that is 

entered in the search box.  



To search/group by specific columns simply drag and drop the desired column 

headers into the gray area below the search. To remove them from the specific 

search simply drop the header back into the grid.  

The following screen will open. Click on the ‘+’ to expand the records. 

Once the desired Record is found, open and view it by double clicking on it and the 

detail view will open in Data View. 



Units – User Defined Fields    

User Defined Fields enable you to customize hierarchical searches through the 

equipment table based on your priorities.  You can use the 21 User Defined Fields 

for anything you wish to track that has not been included in the standard fields.   

You can also make the User Defined tab your primary tab that appears first and use 

the fields for data very specific to your needs.  The screen is shown below, and it will 

be discussed during training. 



Access the user defined fields with the following combination of tab orders: 

Administration > Configuration > Equipment (Units) and Define Units Screen 

Layout. 



Design Screen Layout button for Data Fields  

Express Maintenance® has 21 user definable fields.  You can define the caption of 

the User Defined tabs as needed.  To change the caption of the tab or any of the 

fields click the Define Units Screen Layout Button  in the configuration 

menu, this will show the Units Layout Template. Use the screen to label User 

Defined Fields, arrange Standard Predefined Fields, and Arrange Tabs order.   

Assigning PM Services to Units 

For each Equipment (Unit) record there is a tab labeled Services (PMs) which is 

used to attach planned services from the Services Table (covered elsewhere in 

training) to Equipment to create Scheduled Services. The scheduled services 

represent Planned (PM) work and will be converted to Planned /Scheduled WO’s 

using the Service Overview.  

To perform the process of Scheduling Services to the Equipment records go to the 

Units (Equipment) screen and open the desired record.  Click on the tab labeled 

Services (PMs) and the following screen opens. For Time or Counts based 

Scheduled Services (PMs) click the ‘+’ and a blank service line is opened. 



Click on the dropdown arrow in the corner of the Service field. The dropdown 

screen opens to select the Service (PM) for scheduling.    

Select the Service by clicking on it and it will fill into the Services (PM’s) field as a 

scheduled service.  

To schedule for Time based PM enter the Last Date Performed or the Scheduled 

Date, whichever you are using.   



With the Last Date Performed entered save with the ‘√’ and the Scheduled Date will 

fill in based on the Renewal Schedule that was created using the scheduling tool 

when setting up the service in the Services Table (covered elsewhere).  

To schedule by Counts, repeat the procedure only this time enter the Last 

Performed Count save with the ‘√’.  

Should Equipment have both Time and Counts just list the Service twice, the first 

time enter Last Date Performed or the Scheduled Date, whichever you are using, 

and when listing it the second time click the ‘Clock’ icon (Scheduling Tool)  

And the screen below will open. Set the Counts and Count Interval and the close the 

Scheduling tool by selecting  .  



After entry save with the ‘√’ and the Scheduled Count will fill in based on the 

Renewal Logic that was created using the scheduling tool.  

Adding Parts to Scheduled Services 

Once a Service is scheduled to an Equipment and saved, Parts can be added using 

the Parts button in the Context Menu.   

Click on the button and the screen opens: 

Click the ‘+’ and the Parts dropdown screen opens. Click on the   and a table with 

parts listed is presented as shown below: 



To select and attach Parts, just click on the part and it will be added to the Service. 

Add the Quantity and then click the   to save. Repeat for additional parts, and 

close when done. These parts will then be printed on the Work Order generated for 

the Scheduled Service under the Parts tab. 

Other fields can be completed during the Service scheduling such as Work Group, 

Cost Codes, and Separate WO etc.  

After a Service has been scheduled to an Equipment record only two things can be 

changed in the Services Table (Administrative > Services). They are the Service 

Name and the Notes Fields which will flow through and are updated in the 

scheduled services. All other fields involved with the Scheduling are not affected 

and need to be done on an individual equipment (unit) basis.  

The Status field starts out as ‘Normal’ when a Service is scheduled.  

Once it is converted to a WO the Status goes to Assigned.  Upon closing of the WO, 

the Status will go back to Normal.  The details of this process will be covered during 

later training. When Equipment status is changed from Active to Inactive make 

sure any Scheduled Services status is also changed to Inactive. 
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Introduction 
In this training document we will demonstrate how to create Preventative Maintenance 

(PM) Work Orders (WO’s) from scheduled services, as well as Demand WO’s to cover 

breakdowns and or other requests for services. We will also cover the proper closing of 

WO’s to include parts used, personnel doing service(s), Man Hours, Down Time and WO 

total cost. Let’s get started.  

Work Orders 
Work Order Screen 

Work Orders -- Express Maintenance Screen Menu  

Work Orders are used to track Planned and Demand (Breakdown) work coming from 

Scheduled Services, Work Requests or manual Work Orders. Within the Work Orders 

option, Users can review maintenance issues that are due as well as create, assign, print 

and update Work Orders all from the same window.  Click on Work Orders and the Work 

Order Screen opens. It will default to the Work Orders Overview tab.  



Using the Service Overview to Create Planned Work Orders (PM, PdM, PD)  

To create Planned Work Orders from Scheduled Services, use the Services Overview. To get 

to the Service Overview screen go to Maintenance > Service Overview and click on it. And 

the Service Overview opens. 

The Service Overview is used to lookup Services that are due, what Equipment it is 

scheduled for, and to convert them to Work Orders as the User desires.   

To look at what services are due within a date range, enter the from and thru dates in the 

indicated boxes. 

Hit the search button   and a list of Services due between the dates desired will 

be shown in the bottom frame. 

The other boxes: Site; Location; etc. can be used to narrow the search. This is especially 

good if you have many Units and scheduled Services. 



You can also use the calendar icon to view scheduled services. Clicking on the calendar 

icon:  

will open the following screen. Any services due will be entered into the calendar on the 

date scheduled. You can view a week by clicking on the side of the small calendar or you 

can display just one day by clicking on the day you want on the small calendar. To return to 

normal view, click on Service Overview. A different month can be viewed by using the 

arrows on each side of the month label on top of the small calendar. 



Double clicking on any service on the calendar will open the following information screen: 



To convert a scheduled service to a Work Order, click ‘Picked’ on the left and that 

scheduled Service/s will be converted to a Work Order by clicking the Create Work Orders 

(highlighted by dark green square) button on the task bar.  

To select more than one scheduled service there is a Selection tool available. Clicking the 

drop-down menu on the circled check mark opens the dialog box. Clicking on Select Items 

drop down menu open the next dialog box. You can then select all of one of several 

different combinations to select services.



Once the Pick Selection(s) have been made, click ‘Create Work Orders’ as shown above, 

and the Create Work Orders tool opens for use in entering scheduling and other 

information. The User can leave it blank and create the Work Orders and fill in the 

information fields on each individual Work Order after the fact if desired, but this not 

recommended.  

For this WO the Scheduled Date, Category, Group, Priority, Requester, Work Group, and 

Employee are entered:



Click  when ready and the ‘Confirm’ box opens: 

If the Work Order is correct, then click ‘Yes’ and the Work Order/s are created and the ‘Print 

Work Order’ Tool opens. 

The User has the options of Preview, Print, Email, or Close. 



To review the Work Order/s just created the User can go to the Work Order tab or the 

Work Order Overview tab, both of which are found on the same screen as the Service 

Overview tab.  

Services are placed on Work Orders by Unit and Work Group.  If a Service has a Check in 

the Separate Work Order box, then the service will also be placed on a separate Work 

Order. If the box is unchecked, one Work Order can have multiple Services on it if they are 

processed at the same time 



Creating Demand Work Orders (WO) 

To create Demand Work Orders - go to Maintenance. Click on Work Orders and Work 

Order Data. To add a new demand Work Order, click on the ‘+’ and the screen opens ready 

to add a new Work Order (WO): 

A Work Order ‘Number’ will automatically be assigned when the WO is saved after data 

entry.  

Unit is the first field to enter and that is done by clicking on the dropdown arrow and 

selecting the desired Unit (Equipment). As an example, to find the Conveyor and create a 

Demand WO for it, we type the letters or numbers of the Equipment (Unit Name) and the 

list will quick position to that record.  



Site/Loc. Will automatically fill in. 

Company and Started are optional. 

Completed is filled when the WO is complete (finished/done). 

Reference comes from Express Request, so it will be empty.   

Category is selected from the dropdown shown below. In this example the issue is a 

breakdown of equipment so ‘Demand - Reactive’ is selected.  



Group and Class are not in use and are left empty; we are done with the left column and 

now move to the center column.  

Created On will automatically be filled in with the current date. 

Priority is selected from a drop-down menu shown below. 



Source dropdown is clicked.  Since this a manually entered demand WO ‘Manual’ is 

selected. 

Requester is the person who requested the work.  

Work Group is the group responsible or doing the work, for example: Maintenance. 

Technician is entered if the person doing the work is known, if not leave blank and it can 

be filled in later.   

Labor Rate / Hours: The Labor Rate should be entered automatically if a labor rate for the 

Technician has been entered in their Employee sheet under >Administration>Employee. 

Hours will be entered upon Work Order Completion. 



Work Order Notes is usually where a description of what is to be done is entered by the 

Requester.  



At least one Service must be entered under the service tab. 

To enter a service, go down to the Service section of the WO. Click on the ‘+’ to add a 

service. Then click on the drop down to open the Services listing.  

Choose a service; in this case ‘Belt – Repair’  



Parts, if known can be added now by clicking on the Parts tab, and then on the ‘+’. 

Clicking on the   will open a drop-down menu of parts. 

After adding the parts, click on the  .  



The Attachments tab is where documents stored outside of ExpressMaintenance® can be 

attached to a Work Order for the Technician. To add and Attachment, click on the ‘+’. 

Then clicking on the   will open a drop-down menu of Attachment types. Choose the type, 

and then enter the link info under Reference.  



Technician Notes is an area that the technician can post any notes, observations and 

other information he needs to pass on.  



When done Save by clicking on the Green Check Mark   , and the WO will look like this: 

Note: Do not click on the large green Check Mark   as this will complete the Work 

Order!!! 

Note: If the Equipment is ‘Count’ based the current Count can be entered and the 

Completed date will be used for the Count Date. When the WO is completed the Count and 

Count Date will be updated in the Equipment record. If counts are not in use leave it blank. 

Downtime is entered after the repair is complete and before closing the WO.  

Notes need to be entered. These ‘Notes’ are a description of the Problem or issue the 

Equipment is experiencing and what needs to be repaired. The Notes field has an Editor 

which can be opened by right clicking in the box and clicking on Editor. Once notes are 

entered save with the ‘√’.  The WO is saved and as displayed above; the WO ‘Number’ is now 

present (61). The WO is now ready to be emailed, printed or looked up by the technician to 

review prior to doing the work requested.  The editor use for notes will be explained and 

demonstrated later in the training. 



Creating Work Orders (WO) from Express Request (ER) 

ExpressRequest® (ER) is a separate program to allow non-maintenance employees to 

submit work requests to the Maintenance Department.  If your organization uses 

ExpressRequest® then whoever submits the work request through Express Request will 

automatically fill in the Requestor field in the Work Order screen.  

In addition, the Request Number will fill into the Reference field. For this reason, using the 

Reference field for other purposes is not recommended if you are going to use ER.  

If you have requests from ExpressRequest® (ER) that are awaiting a response, the following 

Icon   at the bottom of the screen in ExpressMaintenance® will be ‘flashing’.  To 

create Work Orders from Express Request (ER) - go to Maintenance. Click on Work 

Orders, then Requests, or click on the   icon. The following screen will open. 



Click on the ‘Search’ icon  , and the search screen opens as below. Enter a ‘From Date’ 

and a ‘Thru Date’ into the indicated blocks, and then click on Search’. 

Other search criteria can be entered also, i.e. Site and Location for example, to narrow the 

search.  

Once you have selected the Request(s) to be converted into WO’s, click ‘Assign Work 

Order(s)’, 



And the following screen will open. 

Fill in the data groups (Scheduled; Category; Group; Class; Priority; Work Group; 

Technician; (Requester will be filled in automatically)), and then click on , and the 

confirm screen will come up: 

If all the data groups are not filled in, you will receive an error message that the blank 

group must be filled in. 



Click on ‘Yes’ or ‘No’ to confirm and the new WO’(s) will be shown in ‘Work Orders Data’, 

as shown below. 

Using Work Orders Overview 

You will use the Work Order Overview to lookup both Scheduled and Completed Work 

Orders – go to Maintenance> Work Orders> Work Orders Overview.  



The ‘Status’ box opens when clicked to choose Open, Completed, Both or Created.  

The default Status is Open, choose a date range or leave blank and get all Scheduled WO’s. 

Other filters are available, select desired filters and when ready click ‘Search’ and the list of 

Work Orders will be displayed that meet the specified filter criteria. You can also filter a list 

of WO’s for a specific Site and/or Employee. 

To print a list of Work Orders or the WO itself use the ‘Print Menu’, you can choose from 

three options of Print List of Work Orders, Print Flagged Work Orders or Print Selected 

Work Order 



To view the desired work order, double click on Unit Name,  

it and it will open in the Work Order screen. 



Completing Work Orders 

Completing (Closing) Work Orders can be accomplished from either the Work Order 

Overview or the Work Order Screen – go to Maintenance> Work Order Overview. 

Choose the work order that is to be completed (closed) and double click on it, 

and it opens in the work order screen. 



To close a WO, it is recommended that the User start from the bottom and work up. Start 

with the Parts tab, and enter all parts utilized. Then go to the Services tab and enter all 

services performed. Then fill in the middle column (if necessary, it may only be the Count /

Downtime or Labor Rate / Hours, the rest should be filled in automatically), and then the 

left column. When the WO is saved, the right-hand financial column will automatically fill in.  

Entering Parts 

Entering Parts—click on the Parts tab, and then the ‘+’ in the Parts Section,

and the Parts dropdown will open. 



Parts dropdown: 

Select the desired Part and click on it and the Parts information will fill into the screen.   

Enter the Cost Center, Quantity, Cost if not present and check ‘Tax’ if applicable, when 

complete click the   and the Part record is complete.  To insert additional Parts, click on 

the   and the screen opens ready to add another Part, repeat the process until all Parts 

used are added.  



Services—There must be at least one ‘Service’ under the service tab of the WO (at least 

one is required to open a WO). If additional ‘Services’ were performed, or more than one 

Technician worked on the WO, use the   to enter additional services as required.  

If the Service is complete, check the ‘Complete’ box, enter the ‘Performed On’ date using 

the calendar popup.

Enter Cost Center, Employee, and Labor Hours in the appropriate columns, and Service 

Notes (what was actually done) can be entered under the Technician Notes tab. When 

finished save with the  . 

Once Services and Parts are complete; next move to the center column in the top half of 

the Work Order.  



Enter the Counts and Downtime if desired. To enter downtime, open the Downtime Tool by 

clicking on the ‘Clock’ icon .  

Downtime can be added by using the ‘Unit Down’ and ‘Unit Up’ fields, or by entering a value 

in the ‘Hours Down’ field and saving. When done click  and the tool will close, and the 

Downtime will be displayed in the field.   

With the center column complete move to the left column, enter the ‘Completed’ date and 

the WO is ready to be completed.   



Save with the   and the right column fills in with the financial calculations resulting in the 

WO Total Cost.  

To review the Service History or the Downtime History for Equipment records right click in 

the Work Order ‘Unit Name’ field and the jump button menu opens.  

Click on Jump to Unit and the Equipment screen opens. Click on the ‘Service History’ tab 

displays the Service History of the Unit. 



To view Hours Down time, click on the Downtime tab.  

 These topics and others will be explained and demonstrated in later training. 

In conclusion the Work Order screen of Express Maintenance consists of two areas.  The 

top area identifying the equipment (unit); and the bottom area where you can add specific 

services under the Services tab, parts under the Parts tab, and notes as to what was done 

and how under the Technician Notes tab. This enables you to manage everything related 

to Work Orders.  

In the process of creating Work Orders - Equipment, Parts, Services, and other tables of 

data are going to be offered for selection to choose the desired record.  These selections 

are presented with the first field as the Key field which the data is sorted on. Should that 

key field need to change to another (i.e. sorting on Unit Number instead of Equipment 

Name) the Set Lookup Lists Tool is used, and it is found under Utilities. 



Time and Date Stamp in Date fields.  

In the Work Orders screen, in the sections that use dates (Scheduled, Started, 

Completed and Created), the drop down ‘arrow’ will cause a calendar and clock to pop up.  

Just pick the date you want entered (it will default to today’s date). To enter a time stamp on 

any of the above highlighted fields set the time in the area under the clock, Notice the 

Creation Date has a time stamp filled in as well. When you create a Work Order the 

Creation date and Scheduled Date fills in automatically to today’s date.  



When a work order is started, and work is completed each day, the sum effort will show up 

when the Work Order is completed.  To track that level of detail, add the Start Date in the 

Started field. The Started date can be the day of the Scheduled date, or after the 

Scheduled date.  

Codes Screens 

Express Maintenance use the Codes table to store information for selection dropdown lists.  

Codes are important because they enable you and others on your team to ensure that data 

is entered accurately and consistently.  You can edit, delete and insert new codes at any 

time using the Administration > Codes > Codes Setup> Overview or:   



> Codes > Codes Setup> Data View screens.

You can enable and disable code types for the user defined fields only.  All other codes are 

automatically enabled and remain enabled.  

Work Order Categories 

Work Order Categories are important for the collection and sorting of work order results 

for calculations in Mean Time Between Failure (MTBF) and Overall Equipment Effectiveness 

(OEE) equations as well as for Pareto Analysis to get to Root Cause Analysis tools.  The list 

can be populated for review, additions, and deletions as the Team determines.   

Highlighted are two examples of Codes. You can add more as the team determines what 

are needed. You can enable and disable code types for the user defined fields only.  All 

other code types are automatically enabled and remain enabled. 



Set Lookup Lists in Utilities 

The Utilities section includes numerous options one of which is Set Lookup Lists.  

Set Lookup Lists enables you to define the selection fields for Customers, Parts, Parts 

Purchase, Services, Units, and Vendors dropdowns when looking up records.     

You can invoke specific Set Lookup Properties preferences as to what fields should appear 

in these pick lists and in what order.  You can choose to turn on/off name fields as needed.  

These setting are per user and are saved in the Windows \ ExpressMaintenance.ini file.  

The Set Lookup Properties screen opens giving you eight options to select from.  As an 

example, to modify the sort field, click on Set Lookup Lists. When the drop-down Menu is 

presented, click on Units Lookup List.  It is strongly suggested that Unit or Name be 

displayed first in the Units look up list.  



To modify the sort field check or uncheck as desired and arrange columns by clicking on the 

word which highlights it. Use the arrows to move the field to the desired location in the 

Lookup list.  

When the modifications to the sort order and list are complete, save and close and the 

Units table will now sort on the field that is in the first position in the Set Lookup Properties 

tool.  The Tool works the same way for the other Lookup Lists presented.  
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Introduction 

In this training document we will cover a large number of topics that allow you to customize 

Express Maintenance® to you. We will set up Email, discuss how to store and attach 

various files, set up printing, selecting and printing various reports that are available, and 

various utilities that are available in Express Maintenance®. Let’s get started.  

Miscellaneous Topics 

Express Maintenance  – Miscellaneous Topics  

Administration Configuration Menu             

Click on Configuration; under the Administrative tab. 

and the Configuration Screen opens: 



Email Settings 

Email Settings are found here and need to be configured to email WO’s, Requests and 

PO’s, as well as general Email. 

ExpressMaintenance® allows users to email work orders, requests and purchase orders 

directly from within the program.  Use these default settings to setup certain required data 

needed for emailing from ExpressMaintenance®.  The sender of email will always default 

to the email account of the user logged into ExpressMaintenance®.  The recipient of the 

email will default to the vendor for purchase orders and the assigned employee for work 

orders.  This screen declares the server and the login account on that server to be used.  

Also, users can setup a list of default people to copy, subject line and body text. 



General Email 

Clicking on the    of General Email will expand the screen as shown below: 

The various entries are explained below. 

SMTP Server - Specifies that the mail server uses standard SMTP protocol.(example: mail.myserver.net).
ExchangeEWS - Specifies that that the mail server uses Exchange Web Service protocol. Exchange 2007 or later version supports 
this protocol.
ExchangeWebDav - Specifies that that the mail server uses Exchange Web Dav protocol. Exchange 2000/2003 supports this 
protocol.
GmailApi - Specifies that that the mail server uses Gmail RESTful API. 
The Authorization Type is best left to AuthAuto.
AuthAuto - Specifies that the smtp client selects the authentication mechanism automatically. (default and recommended). The 
software will negotiate with the SMTP server and will agree on the highest level of security that both can support.
AuthLogin - Specifies that the smtp server uses AUTH LOGIN mechanism.
AuthPlain - Specifies that the smtp server uses AUTH PLAIN mechanism.
AuthCRAM5 - Specifies that the smtp server uses AUTH CRAM-MD5 mechanism.
AuthNTLM - Specifies that the smtp server uses AUTH NTLM mechanism.
AuthMSN - Specifies that the smtp server uses AUTH MSN mechanism.
|XOAUTH2 - Specifies that the smtp server uses Gmail OAUTH mechanism.
Email Sender IP -  If you must use an IP address, fill it into the SMTP Server Name field
Requires Authentication - This has been replaced with Sender Protocol. The Email software will use the highest level of security 
that it can negotiate with the SMTP server.
TLS Settings - This has been replaced with Authorization Type. The Email software will use the highest level of security that it 
can negotiate with the SMTP server.
Email Account - Specifies the user ID to use when establishing an authenticated connection with an SMTP server. When setting 
the EnableAuth property to the value True, set the value of this property to the user's ID. UserID is the name of the account to 
which the SMTP server grants access upon successful logon. This is usually the name part of the user's e-mail address, but could 
also be a specific account name. The UserID property is used with the Password property to log on to the server. (example: jdoe)
Email Password - Specifies the password to use when establishing an authenticated connection with an SMTP server. When 
setting the EnableAuth property to the value True, set the value of this property to the user's password. Password is the password 
associated with the UserID for a given SMTP account. (example: mypassword)
Mail From - The email address of the person sending the email. (example: jdoe@myserver.com)
Mail To - The email address of the intended recipient. (example: bjones@bigcompany.com)
Mail CC - The email address of a carbon copy recipient.
Subject - The subject of the message being sent.
Attachment - Select a file to attach to the email.
Message - The message content.



Email Sending Option – Optional, Service, Client, Application 

Email Try Times - ExpressMaintenance® will default email tries to three.  Use the 

arrow or type the number of time(s) you prefer ExpressMaintenance® to attempt to 

send an email.  

Attachments Format - Select the type of documents format to be used when 

attaching purchase orders or work orders.  The recommended format is Adobe Acrobat 

(.pdf) as this is universally accepted.  By clicking the drop-down arrow, you can pick 

from the attachment list (.xls, .htm, .rtf).  

Requests Emails 

Clicking on the    of Requests Email will expand the screen as shown below. Requests 

Email handles how Emails are handled when a Request is received from ExpressRequest®. 

If your organization does not use ExpressRequest®, this section can be skipped. 

Email New Requests To - Select the condition under which all new request made in 

ExpressRequest® should be emailed. Clicking the Drop down menu opens the following 

choices for new Emails. 

Requests Only – Adds the List of Recipients to the CC from the Config table called 

“New Request” when an Email is sent from ExpressRequest®. 

Units Only – Adds the List of Recipients to the CC from the “Unit Email” list. 

New Request Recipient List - Create a list of ExpressRequest® recipients using an email 

address.  Simply click the arrow or the existing email to view / edit the email list.  Type one 



email per line and hit enter to add another email.  Click "Ok" or click outside the of the list 

screen to save your email list.  

Subject Line for Requests - The subject line to be placed in all emails generated by 

ExpressRequest®. 

Body Format for Requests - The text to appear in the body of the work order emails.  Click 

button for larger screen editing 

Purchase Order Emails 

Clicking on the    of Purchase Order Emails will expand the screen as shown below. This 

area handles who will receive Emails for Purchase Orders (PO’s) or Request for Quote 

(RFQ’s). 

Subject Line for PO's - The text to appear in the subject line of Purchase Order emails. 

Copy Recipients for PO's - A list of email recipients (separated by semi-colon) who will 

receive a copy of the Purchase Order emails. 

Body Text for POs - The text to appear in the body of the Purchase Order emails.  Click 

button for larger screen editing. 

Subject Line for RFQ's - The line to be automatically inserted on RFQs being emailed. 

Copy Recipients for RFQ's - A list of recipients that will receive a copy of all emailed RFQs. 

Body Text for RFQ's - The body text to be automatically inserted on RFQs being emailed. 



Work Order Emails 

Clicking on the    of Work Order Emails will expand the screen as shown below. This area 

handles who will receive Emails for Work Orders  

Subject Line for Work Orders - The text to appear in the subject line of work order emails. 

Copy Recipients for Work Orders - A list of email recipients (separated by semi-colon) 

who will receive a copy of the work order emails when emailing any Work Order. 

Body Text for Work Orders - The text to appear in the body of the work order emails. 

 Click button for larger screen editing. 

 



Printed Documents Settings 

Printed Document Settings are found in the Work Order section. 

Work Orders is divided into three different sections. General Settings; Charges & 

Auto Apply and Printed Documents. 

Selecting Printed Document Settings opens the above menu:  

Worksheet Reports Options 1-3: When printing work order worksheets, you can 

select from three report formats: With All Service Notes; With All Notes; With 

Service Notes – LOTO (Lockout-Tagout).  

Completed Reports Options 1-3: When printing work order worksheets, you can 

select from three report formats: Completed With WO Notes; Completed With 

Unit Notes; Completed With Service Notes. 

Reports 

Each module in ExpressMaintenance® (Maintenance, Parts Inventory, and 

Purchasing) contains a Reports window for accessing available reports.  

For example, from the Maintenance module, Maintenance Reports as shown 

below.  



By clicking on Maintenance Reports will show a window which contains a left 

panel providing various parameters to be passed to the reports.  The right panel 

lists the available reports.  To run a report, complete the Report Filters in the left 

panel and then click on the desired report from the right panel.  Below is a sample 

from Maintenance > Reports window.  

Reports are Public unless moved to Favorites (this will not remove report from 

public). Report templates can also be imported from the ExpressMaintenance® 

website and exported using the Tool in the Reports screen.  Favorite Report 

templates like Employee Services & Time is useful for using the system to verify 

that all work has a work order and each person is closing their own work orders. 



Other reports that may be useful to add to Favorites are Units Service History; 

Work Order List by Completed Date and Units Listed by Location.   

Favorites: To assign a report as a Favorite, right click on the report and select “Add 

to Favorites”.  Favorites are assigned on a per user/per module basis.  If favorites 

have been selected, then the user will see the favorites list first upon selecting the 

reports window.  With the availability of the Reports Designer, a particular module 

may become crowded with user created reports.  Favorites are a convenient way of 

limiting the view of available reports to those most often used.   

Utilities  

The Utilities section includes options for accessing user friendly tools including 

rolodex, editor, calculator, etc.  The utilities section also provides options to define 

the Main Toolbar Properties and certain key lookup lists.   

App Preferences enable you to define the Main Toolbar Properties as desired per 

user and enables you to define how you would like the interface to appear when 

your run the program.  The settings are saved per user, so each user can select 

their own preferences.  

To modify the screen layout and colors left click on App Preferences, and the 

following screen will appear.   



You can customize the 

appearance of how tables 

etc. appear, by checking Use 

Themes and changing the 

Application Theme. You can 
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Introduction 

In this training document we will cover how to generate Purchase Orders (PO’s) and Request 

for Quote (RFQ). How to receive parts ordered from PO’s generated in Express Maintenance®, 

and last how to track usage of parts. Let’s get started.  

Purchase Orders 

Express Maintenance  – Purchase Orders 

Purchase Orders-- Express Maintenance Screen Menu     

Purchase Orders (PO’s) are found under the Purchasing Menu. 

!

Click on Purchase Orders and the PO screen opens. 

!



The Overview tab allows you to enter search parameters (filters) to find POs. To go to the 

individual PO, just double click on the PO in Overview. And the individual PO opens in the Data 

View as shown below. 

!

Parts Ordering 

POs are entered to place an order with a vendor for Parts or Services. The Purchase Order 

(PO) screen provides an effective method of tracking purchases and their associated costs... 

An overview of the steps associated with POs: 

1. Purchase Order transactions are entered and printed as items are ordered from vendors.

2. As items are received, Purchase Orders are Closed (received), this is done in the Parts/

Receiving screen.

3. Purchase Order Reports are available for Open or Closed Purchase Orders.

The PO Document can be used for a Purchase Order or a Request for Quote (RFQ) by 

checking the appropriate box.  



!

New Purchase Order 

To start a new PO, in the Data View screen, click on the !  and a blank PO screens opens as 

shown below: 

!



Enter desired data in the left-hand column first and then the middle Column. 

!

To select the Items to be ordered, click on the !  and choose the items from the drop down 

menu. 

!



To save them when all desired Parts have been added and the Quantity entered, click on the 

!

!

Save the PO (or RFQ) by clicking the !  at the top, and ExpressMaintenance® will 

automatically enter the PO # as it is saved.  

!



Parts Receiving 

On the Purchasing screen. Click on Parts Receiving: 

!

….and the receiving screen opens. Find the PO you are receiving parts on in the Overview and 

double-click on it, 

!



… or click on Data View, Enter the PO number in the field and click the ‘$’ and the items on the 

PO will display.  

!

If the price of a part has changed from price in the Part Current Cost in the Parts table record, 

enter the new price in the PO for that Part, and click the !  icon  

!

a ‘Confirm’ screen will open to allow you to update with the current price. 

!



Update pricing by clicking ‘Yes’. 

By clicking on the !  the PO will be closed, and the Parts received into Quantity on Hand and 

a Receiving transaction entry is recorded. 

!



If all the parts are not received, you can leave the PO open by modifying the Quantity for a 

receipt that is shipped short, the Parts received will be received and entered into inventory, but 

the PO can be left Open. 

!

Update PO Receiving and Parts QOH by clicking ‘No’, this leaves the PO Open to receive the 

short Part(s).  

Going to the Maintenance tab, and clicking on Parts Inventory, and choosing the part received, 

the Receiving History notes the Receipt.  

!



Parts Usage History 

Usage History comes from consuming Parts on WO’s. All parts listed on a closed WO will be 

removed from Parts inventory in the QOH (Quantity on Hand) field. This makes it important to 

record all parts used in the work order Parts section. 

!
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Introduction 

In this training document we will cover how to generate Reports from 

ExpressMaintenance®, to show the value they bring to the business.  Operations can show 

how much production is made in a month and Sales can show how much business they 

sold each month.  Reports from Express Maintenance® can show how much money they 

retain for the business each month.  

Additional discussion to identify reports for the scope and scale of your application will be 

covered in your on-site training sessions.  Maintenance manager use of 

ExpressMaintenance® with strategic methods utilizing key performance indicators (KPI’s) 

reports that utilize the data being collected in the data base Work Orders and Purchase 

Orders is also available from Manufacturing Asset Solutions.  

Services – List of Types:  
By selecting the Services Icon, you can find under the Overview Tab a list of Services 

currently in your database.  For this example, you’ll find 49 records.  



To create a report of all Service – List of Types, select the Printer Icon on the Service tool 

bar. 

. 

This generates the following report . 

This report can be useful to review your present services for your equipment and 

determine if more need to be added, or some in-activated. Other uses can also be 

surmised. 



This report then can be reviewed or transmitted in any of the following formats: Export 

Report Data; Export Report Document; Email Directly; Print; or Email a pdf.   

Export Data Report 

Clicking on the highlighted icon will allow you to Export Report Data. Another screen will 

open, 

By selecting the format you want to export the data, and then clicking on  a file will 

be created and saved in the location in the File Destination box. 

Export Report Document 



Clicking on the highlighted icon will allow you to Export Report Document. Another screen 

will open, 

By selecting the format, you want to export the document in, and then clicking on 

a file will be created and saved in the location in the File Destination box. 

Email Directly 



Clicking on the highlighted icon will allow you to Email the report directly from 

ExpressMaintenance®. Another screen will open,

Fill in the necessary information (Recipient, CC’s, Request Receipt etc.) and click on 

 and an Email will be sent with the report as an attachment.  

Company Listing:  

Go to the Administration tab and find the Companies Icon.  By selecting the Companies 

Icon, you can find a current list of Companies in your database.  For this example, you’ll find 

40 records.  



To create a Company List report, select the Printer Icon on the tool bar. 

. 

This generates a report that than can be reviewed or transmitted in any of the following 

formats: Export Report Data; Export Report Document; Email Directly; Print; or Email 

a pdf as explained above in Services Reports..   



Employee List:  
Go to the Administration tab and search in the Middle Column to find the Employees Icon.  

By selecting the Employees Icon, you can find a current list of Employees in your database.  

For this example, you’ll find 14 records.  

As in the previous two examples, to create an Employee List report select the Printer Icon 

on the tool bar. This generates a report that than can be reviewed or transmitted in any of 

the following formats: Export Report Data; Export Report Document; Email Directly; 

Print; or Email a pdf.   



Administration Reports 

Report Management under Administration manages many reports, in this example, 245.   

Several different types of reports are listed, we will be only working with a few specific ones 

for this training manual. These reports can be accessed under Administrative>Reports; 

Maintenance>Reports; or Purchasing>Reports. 



Maintenance Reports 

Let’s start with a few maintenance reports, specifically Units by Location.  Go to the 

Maintenance Tab and select Reports. From there Public tab you should find many reports 

to choose from. From the previous chapters in the training documents you should find four 

reports listed under the Favorites tab, select the second item on the list Units by Location.  

The geographic situation that maintenance works in a company site and locations can vary 

from a compact plant to one dispersed through several buildings and over a large area. As 

with the geographical considerations, the actual plant size will dictate the location of 

equipment.   



Units List by Location is one many reports available.  It requires specifying a specific site, 

for this example we will select in the Report Filter: Site: MAS Industrial Fab from the drop-

down menu, and then the Machine Shop Area.  

Click  and we now have this in the report filter section: 



Now check the box for Units List by Location and the following report is generated.  Note: 

Ideally, each equipment (unit) should have an identification tag on it with the Unit number 

linking the physical location of the asset to the equipment list location.  

Additional discussion that is specific to your application will be covered in your on-site 

training sessions, including but not limited to exporting Units by Location of equipment and 

critical equipment from ExpressMaintenance® to spreadsheets.  



Parts Reports 

Parts Reports have many reports to choose from the Public tab, for this example let’s 

select Parts List by Location that has been added to the Favorites tab. Go to the 

Maintenance Tab navigating to Parts Inventory and select Reports.  

The geographic situation for material and parts storage for a company site and locations in 

a compact plant will vary from that in one dispersed through several buildings and over a 

large area.  As with the geographical considerations, the actual plant size will dictate the 

location of part storage locations.    



The report requires specifying a specific site, for this example we will select in the Report 

Filter: Site: MAS Industrial Fab from the drop-down menu, and then the Machine Shop 

Area.  

Now check the box for Parts List by Location and the following report is generated.  Note: 

Ideally, each part or material inventoried should have a Location, Shelf and Bin with the 

Unit number linking the physical location of the asset to the Units List by Location for Parts.  

Additional discussion that is specific to your application will be covered in your on-site 

training sessions, including but not limited to exporting Units by Location of parts and 

critical spares inventory from Express Maintenance® to spreadsheets.  



Work Order Reports 

Work Order Reports have many reports to choose from the Public tab. Work Order List 

by Completed Date has been added to the Favorites tab. Go to the Maintenance Tab 

navigating to Reports Icon and select Work Order List by Completed Date from the 

Favorites tab.   



This generates a report that then can be reviewed or transmitted in any of the following 

formats: Export Report Data; Export Report Document; Email Directly; Print; or Email 

a pdf.   

Purchase Order Reports 

Purchase Order Reports have many reports to choose from the Public tab. Purchase 

Orders – By Cost Center Summary has been added to the favorites list.  Go to the 

Purchasing Tab> Reports Icon and select Purchase Orders – By Cost Center Summary from 

the Favorites tab. 



To create a report of all Purchase Orders – By Cost Center Summary, select the Printer Icon 

 on the Purchase Order Reports tool bar. 

This generates a report that can Print.   

Additional discussion that is specific to your application will be covered in your on-site 

training sessions.  

In conclusion, reports are essential to making better choices based on data and facts.  
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Introduction 

In this training document we will demonstrate how to use Express Request® to generate a 

work request for use with ExpressMaintenance®.  During the last 25 years, the 

maintenance field has seen significant change in the documentation of equipment and 

related parts.  Nowhere is that change seen as revolutionary as the introduction of 

electronic data and retention of records.  Let’s get started.  

Express Request 

Express Request – Entering Requests 

Too often verbal work requests result in performance of unimportant, unauthorized, 

unnecessary, and even unwanted work.  To reduce the possibility of this happening, it is 

essential that all requests for maintenance services be submitted in writing.  Requests for 

service may be initiated by maintenance or productions personal desiring to have work 

performed.  The work order system and its procedures provide a uniform means of 

information flow for requesting, planning, scheduling, controlling, recording, and analyzing 

the performance of all work done by the maintenance department.  A single common 

means of transmitting requests for services by the maintenance department that increases 

the probability that the information needed by the maintenance department to perform 

the work will be included in the order begins with here 

Express Request – Launch and Configuration (Setup) 

To start Express Request, double click on the Express Request Icon shown below. 

Select your name in the Select Requester box.  



. *** Note: If you do NOT see your name you will need to be added by your administrator 

through the Express Maintenance program 

The following screen will open: 

Entering Requests 

Select   from the top context menu. The following screen opens. 

 



Go to the Unit / Equipment box and click on the down arrow   in the right-hand corner 

and the following appears. 

Choose the Unit Number, in this case, Furnace - 001 and the following appears.  

Finish filling out the fields per your company’s SOP, add any text to the notes sections per 

your company’s SOP and select the    to submit the request.  

Reviewing Requests 

To review your request, click on Overview, and then click on the Submitted tab on the left 

in the Request Status box. 



The maintenance team will now receive a notification letting them know this request has 

been submitted and you can now track the status of this request all the way to completion. 

Be sure to keep up with your critical requests.  

When the Request is converted to a WO the Request will move to the Assigned list Request 

Status box, to view assigned Requests click there.  

Action taken by the Maintenance Department will be added to the to the request text and 

displayed in the notes window, see below. 



Notes Window:  
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Introduction 

In this training document we will cover how to utilize Report Writer to either build a new 

report or modify an existing report. Let’s get started.  

Report Writer 

Express Maintenance – Report Creation and Modification 

Report Writer 

To access the Report Writer, you can go to any “Reports” screen such as Maintenance and 

then Reports as indicated below. 

New reports can be created either by starting from scratch or by modifying an existing 

report.   

Creating a new Report 

To create a new one, click the second icon from the left on the tool bar of the Maintenance 

Reports window.  When the window opens it looks like this: 



You are then able to create an entirely new report using the tools provided. 

Modifying and existing Report 

It is usually easier to modify and existing report rather than creating one from scratch. To 

modify an existing one, find the report that is closest to what you want to create and open 

it.   

Report builder will open.  



Once open you will see that there are three main tabs.  They are Data, Design, and 

Preview.   

➢ The Data tab is used to select the data that will be displayed on the repot.

➢ The Design tab is used to define the content and layout of the report.

➢ The Preview tab is used to display the finish report as it will look in printed format.



Data Tab 

The Data tab attempts to simplify the data selection process but should still be used with 

caution.  A solid understanding of SQL and database structure will come in very useful if 

making changes on the data tab.  This is what the Data tab looks like.  You can go to this 

screen to see what rows are being used in the data set. To add a new field from a table that 

is already part of the dataset, click on the third icon from the left on the toolbar. 



You should see a screen like this: 

The top half of the screen is all of the available fields that are in the tables and that are part 

of the data set (Data Base). The bottom half of the screen is all of the fields that are used in 

the Report.  Double clicking on a field in the top part of the screen adds it to the list of 

Selected fields in the bottom half of the screen.  When done selecting fields, click OK.   

Design Tab 

Now click on the Design tab.  You should see something like this: 

If you are modifying an existing report, we strongly suggest that you save the report now 

with a new name, so you don’t overwrite the existing report.   

The toolbars and columns on both sides of the screen can be turned on and off from the 

View Toolbars menu.   



Looking at the Illustration below, the Report Tree gives an outline of the report. The 

column on the left bottom part is the Property settings for the currently selected object.  

The Data Tree on the right-hand side of the screen allows you to take a field and drag and 

drop it onto the report.   

The report itself is made up of several important “bands”.  These bands are Title, Header, 

Group Header, Detail, Group Footer, Footer, and Summary.  The Title is usually static 

text and not data from the data set.  The Title band appears once at the beginning of the 

report and usually contains the title or name of the report.  The controls or objects on the 

Title band are typically labels.  To change the text that displays in the label, select the label 



by clicking on it.  Then click on the box that shows the text from the label on the toolbar. 

You can then change the Text that will appear in the report. 

The Header band appears at the top of each page and usually contains the column names 

for the columns of data that make up the report.  The Group Header and Group Footer 

are optional and are turned on an off from the Report menu and then Groups option.  

Groupings are used if you want to group the data on the report by a certain field.  For 

example, this report a is a list of Units but grouped together by Category.  The finished 

result looks like: 

The Title band shows up at the top of the report, followed by the Header.  The group 

header is the categories such as 1600, 1800, 7 Stage Evaporator.   

The next band is the Detail band.  This is the band that contains the actual data.  The 

Detail band will repeat for every row of data in your data set.  If the number of rows 

exceeds a page, the Header band will show up on the top of the next page and the Detail 

band will start repeating again.  Typically, the detail band contains only one row of data but 

in the event that doesn’t give you enough room, you can put your mouse on the bottom of 

the detail band and pull it down to make room for a second or third row of data.   

The Detail band is followed by the Group Footer and the Footer.  The Group Footer 

appears at the end of a group of data i.e. a group of units with the same Category.  The 



Footer appears at the bottom of each page.  The Summary band appears at the bottom of 

the report and is typically used to sum up the report by showing totals or number of 

records. 

Removing a Field 

To remove a field from an existing report, click on the field in the Detail section.  It should 

appear selected.  You can then press the delete key.  Then do the same thing with the 

column heading in the Header section.  You can also do this in one step by clicking the box 

in the detail section and then holding down shift and clicking on the box in the header 

section.  Then press delete to remove both.   

Adding a Field 

To add a field to the report, find the field you want to add in the Data Tree on the right-

hand side of the page, then drag and drop it onto the Detail band of the report.  The report 

builder adds two boxes to the report.  The first is the field name and the second is the 

actual data.  For column reports like this example, the field name needs to go into the 

Header section.  To do this, you must first click on something other than the new field to 

unselect the field name and data.  Then click on just the first box which is the Column 

name and drag it up to the Header band.  Now you can place the data box exactly where 

you want it.  If you are modifying an existing report, you will probably have to change the 

font characteristics of the new boxes to match the existing fields.  To do this, click on the 

box and then use the font tool bar to select the right font and font size.  You may want to 

click on an existing field to see what the font settings are for it.   

Once you have the font settings correct, you may want to line the new fields up a little 

better with the existing fields.  The easiest way to do this is using the Align or Space 

toolbar.  If it is not on already, turn it on using the View – Toolbars menu.  The toolbar 

looks like this: 

The trick to using this toolbar is to remember to first select the field that is already placed 

where you want it and then hold down shift and click on the field that you want to align up 

with it.  Then click on the toolbar button that does the task you want done.   

Another way to help line things up and match sizes with existing objects is to use the 

Property list.  For example, if you want to make one box the same width as another box, 

click on the first box and check the Width setting in the Property list. 



Now click on the second box and change the Width property to 2 to match the first box. 

If you are having a hard time fitting all the fields you want across the Detail band without 

making them too short, you can change your report to Landscape mode.  To do this, click 

on File and then Page Setup.   

The following screen should appear: 



Click on Paper Size and then on Landscape. You can also change several of the other 

settings of the report. 

When you are done modifying the report, be sure to click on the File menu and choose 

Save or Save as.  This menu option is not available on the Preview Tab so make sure you 

are in Design mode.  After you have saved it and exited the Report Builder, you may have 

to close and re-open your Maintenance Reports window for the new report to show up.  

From this window, you can import and export reports to a file by right clicking on the report 

name for transferring from one Express Maintenance installation to another.   
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Introduction 

In this training document you will be shown how time expended on Capital Projects can 

be charged and tracked in ExpressMaintenance® (EM). The purpose is to allow generating 

of reports and track labor and other costs for Capital Projects. 

Entering a Capital Project into EM 

To track time and information on a Capital Project, it must first be entered into EM.  Many 

Capital Projects involve the installation of new equipment, or maybe several pieces of 

equipment. You will normally wish to track labor (time) on the overall Capital Project and 

not on individual pieces of equipment at this point. In this training we are going to assume 

that this is what you desire to do. The best method to do this is to enter the Capital 

Project into the equipment (unit) table as ‘Equipment’, and also into the services table as a 

‘Service’. This way, the time expended on the capital project can be attached to a Work 

Order (WO) and tracked in EM and various reports generated. 

The easiest way to do this is as follows: 

1. Develop information on the Capital Project that should include as a minimum:

a. Project Name

b. Accounting Cost Center Number

2. Create the Capital Project as ‘Equipment’ in EM.

3. Enter project information into EM as a ‘Service’.

4. Open a Work Order (WO) for the capital project.

When this information is in EM, then WO’s can be generated, and time, labor and if desired, 

parts can be tracked, and various reports generated. 

Entering a Capital Project ‘Unit’ into EM 

To add the Capital Project into EM, first go to the Maintenance>Equipment screens. 



To add the Capital Project. click on the   on the data navigator.  

The screen opens ready to add the Capital Project record as equipment (unit): 

Enter the Name (of the project), Type, Category, Site/Location, and other fields of 

information as desired and save with the  .   



The screen should look something like this: 

We have chosen Capital Project – Production Modernization as our project 

name. Notice that both Type and Category sections have been coded as ‘Capital’. 

If this code is not already in the codes table for those sections, you will have to add 

them as follows: 

1. Click on the dropdown arrow on either the Type or Category selections.

2. The dialog box below will open. Select <Manage Codes>.



3. The Codes Setup screen for Type or Category (depending on which one you

selected) will appear:

4. Click on the  to add a new code. 

5. Enter the information in the Code and Description areas.

6. Then click on the save   to save the information.  



Entering a Capital Project ‘Service’ into EM 

To enter the Capital Project as a ‘Service’ into EM, go to Administrative>Services. Click 

on the  , and the Data View screen opens ready to have a new ‘Service’ information 

entered. 



Follow the same steps outlined in the Services Training Document, but instead of 

entering a PM or Repair Service Name, enter the Capital Project Name in the 

Service Name, Capital in the Category, and accounting’s Capital Cost Code into 

the Cost Center Boxes and save with the  . It should appear as follows: 

If the Cost Center has not been previously set up in EM. You can accomplish that by: 

1. Clicking on Administrative>Cost Centers.

2. Enter the information and click on the   to save the information.



Tracking Capital Project Time 

Once the Capital Project has been entered into EM, you can then track the time expended 

(as well as other information) on the project by opening a Work Order (WO). 

Creating the Capital Project Work Order 

Open the WO Screen by clicking on Maintenance>Work Orders and the Work Order 

Screen opens. It will default to the Work Orders Overview tab.  



Click on the Work Orders Data tab and then the  to create a new work order.  



Enter the information as described in the Work Order Training Document. the Unit name 

will be the capital project you entered. Enter the Category and Group information. Then go 

to the Services section of the work order. Click on the   to add a new service. In the 

dropdown menu, select Capital Project (or whatever you place in the Services table 

above. Once all the desired information has been included, do not forget to click on the 

to save the WO. The WO Number will now be inserted. 



Recording Capital Project Time (Work) 

To record time on a Capital Project, go to the Services section of the Work Order 

For work each day, check the ‘Complete’ box, enter the Performed Date, Cost Center (if 

not already entered), Employee, and Hours. When finished save with the ‘√’ in both the 

Services section of the WO and the top of the WO to save the Service change to the Work 

Order. The Calculations section of the WO will be automatically updated. 

Leave the ‘Completed’ date blank in the top half of the WO until you are ready to complete 

the work. Add the same Service each day for each Employee (including contractors if 

desired) that works on the Capital Project, and repeat for each day of the week. At the end 

of the week or month or at end of project, enter a Completed date in the top half of the WO 

and that Work Order will be completed and closed.   



To obtain a Report on Capital Project Hours  

In the main menu at the click on Maintenance>Reports. This opens the Reports screen.  

If the Work Orders are not ‘Completed’ yet select ‘Performed Date’ in the ‘Use Date’ field. 

If the WO’s are Completed (closed) then use the ‘Completed Date’ in the Use Date field. 

Select the ‘From Date’ and ‘Thru Date’. That the Report is being run for. Select Unit 

Category ‘Capital’. 

Select the Report in the Public reports tab named: Units Expense Summary and click on it 

and the Report will display the Capital Project Hours by Capital Number Service 

Save or Print the Report as desired. Other reports are available and can be customized to 

fit your needs.
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